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Product information

About this guide

CAUTION! ABBREVIATED SAFETY ALERTS. Hazard symbols and hazard
types specified in procedures may be abbreviated in this document. For the
complete safety information, see the “Safety” appendix in this document.

IMPORTANT! Before using this product, read and understand the information in the
“Safety” appendix in this document.

This guide provides reference information for using the Ion PGM™ System.

Note: For information on conducting sequencing experiments, consult the user guide
for your Ion PGM™ sequencing kit.

Instruments and server

Components Cat. No.

Ion PGM™ System and accessories 4462921

Ion PGM™ Torrent Server 4483643

Ion Chip™ Minifuge:

   120 VAC

   230 VAC

 

4479672

4479673

1

Purpose of this
guide
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Kits compatible with the Ion PGM™ System

Item Cat. No. LIterature

Chips

Ion 314™ Chip v2 4482261 See your sequencing user guide for
instructions.

Ion 316™ Chip v2 4488145

Ion 318™ Chip v2 4488146

Ion template preparation kits

Ion PGM™ Template IA
500 Kit[1]

A24622 Ion PGM™ Template IA 500 Kit User
Guide

Ion PGM™ Hi‑Q™ OT2
Kit[2]

A27739 Ion PGM™ Hi‑Q™ OT2 Kit User Guide

Ion PGM™ Hi‑Q™ View
OT2 Kit[2]

A29900 Ion PGM™ Hi‑Q™ View OT2 Kit User
Guide

Ion PGM™ Hi‑Q™ Chef
Kit [2]

A25948 Ion PGM™ Hi‑Q™ Chef Kit User Guide

Ion PGM™ Hi‑Q™ View
Chef Kit[2]

A29902

Ion PGM™ Hi‑Q™ View Chef Kits User
GuideIon PGM™ Hi‑Q™ View

Chef 400 Kit[2]
A30798

Ion PGM™ Template OT2
200 Kit[3]

4480974 Ion PGM™ Template OT2 200 Kit User
Guide

Sequencing kits

Ion PGM™ Hi‑Q™

Sequencing Kit
A25592 Ion PGM™ Hi‑Q™ Sequencing Kit User

Guide (MAN0009816)

Ion PGM™ Hi‑Q™ View
Sequencing Kit

A30044 Ion PGM™ Hi‑Q™ View Sequencing Kit
User Guide (MAN0014583)

Ion PGM™ Sequencing
200 Kit v2

4482006 Ion PGM™ Sequencing 200 Kit v2
User Guide ( MAN0007273)

Ion PGM™ Hi‑Q™ Chef
Kit

A25948 Ion PGM™ Hi‑Q™ Chef Kit User Guide
(MAN0010919)

Ion PGM™ Hi‑Q™ View
Chef Kit

A29902 Ion PGM™ Hi‑Q™ View Chef Kits User
Guide (MAN0014571)

[1] 500-base-read libraries
[2] 100- to 400-base-read libraries
[3] 200-base-read libraries

Chapter 1 Product information
Kits compatible with the Ion PGM™ System 1
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Before you begin

For additional safety information, see “Safety“ on page 45.

Site requirements

For site requirements, see the Ion PGM™ System Site Preparation Guide (Pub. No.
MAN0007516).

Update the software

IMPORTANT! Before proceeding, make sure that you have updated the Torrent
Suite™ and Ion PGM™ System software to version 5.0 or later. See “Update the Ion
PGM™ System software“ on page 13.

Nucleic acid contamination

IMPORTANT! A primary source of contamination is DNA fragments from previously
processed samples. Do not introduce amplified DNA into the library preparation
laboratory or work area.

IMPORTANT! Possible contamination can occur during the transfer of dNTPs into
Reagent Tubes. Be careful to avoid cross contamination of dNTP stocks. Barrier tips
are required for all pipetting steps. Change gloves after handling concentrated dNTP
stocks.

Instrument vibration and clearances

IMPORTANT! Significant vibration during sequencing may add noise and reduce the
quality of the measurements. The Ion PGM™ System must be installed on a bench that
is free from vibrations or in contact with equipment that can cause vibrations to the
bench (freezers, pumps, and other similar equipment).

IMPORTANT! Position the Ion PGM™ System so that the front bezel is a minimum of
12 in. (30.5 cm) and the Reagent Tubes containing dNTPs are a minimum of 8 in.
(20.3 cm) from the front of the laboratory bench. Place the instrument at least 40 in.
(1 meter) away from major sources of electronic noise such as refrigerators or
microwaves.

2
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Static electricity

IMPORTANT! To avoid possible damage to the chip from static electricity, prior to
handling chips, you must ground yourself on the grounding plate (located next to the
chip clamp) by touching the grounding plate with your bare hand.

Do not place chips on non-grounded surfaces such as a bench.
Always use the grounding plate to hold chips that are not in the package inserted in
the chip clamp or the Ion Chip™ Minifuge bucket.

CO2 contamination

IMPORTANT! Dry ice (solid CO2) must be kept away from areas where buffers, wash
solutions, or sources of molecular biology grade water for the Ion PGM™ System are
used. High air concentrations of subliming CO2 may change the pH of such buffers
during or after their preparation. The stability of the pH of these buffers is a critical
factor in the performance of the Ion PGM™ System.

Ventilation requirements

WARNING! Instrumentation must be installed and operated in a well-
ventilated environment, defined as having a minimum airflow of 6–10 air
changes per hour. Assess the need for ventilation or atmospheric monitoring to
avoid asphyxiation accidents from inert gases and/or oxygen depletion, and
take measures to clearly identify potentially hazardous areas through training
or signage. Please contact your Environmental Health and Safety Coordinator
to confirm that the instruments will be installed and operated in an
environment with sufficient ventilation.

Instrument should only be moved by trained personnel

IMPORTANT! The Ion PGM™ System is installed by trained Life Technologies service
personnel and should not be moved.

Chapter 2 Before you begin
Static electricity 2
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System components

Ion PGM™ Sequencer ports and power switch

1 5 64

7

32

8

Label Component Description

1 Instrument fan cover IMPORTANT! The fan cover must be
unobstructed to ensure adequate cooling and
proper functioning of the Ion PGM™

Sequencer.

2 On/off switch Power switch, where the states are on ( | ) or
off ( O ).

3 Power port 100-240VAC port that provides power to the
instrument.

4 USB ports Connects the barcode reader to the
instrument.

3
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Label Component Description

5 Ethernet port An RJ45 port that provides Ethernet (Gigabit)
communication with the Ion PGM™ Sequencer.

6 RS232 port An instrument diagnostic port

7 Gas inlet For nitrogen gas.

8 iPod™ port A port for docking your iPod™ portable media
player

Ion PGM™ System with Reagent and Wash Bottles attached

6

1

2

3

4

5

7 8 9

10

11

12

13

1 Touchscreen
2 Chip clamp
3 Grounding plate
4 Power button
5 Reagent Tube Sipper
6 Ion Chip™ Minifuge
7 Barcode scanner

8 Collection tray
9 Reagent Tube

10 Waste Bottle
11 Wash 2 Bottle (W2 position)
12 Wash 3 Bottle (W3 position)
13 Wash 1 Bottle (W1 position)

Chapter 3 System components
Ion PGM™ System with Reagent and Wash Bottles attached 3
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System layout

We support the layout in which the Ion PGM™ Torrent Server is directly connected to
the Ion PGM™ Sequencer, rather than through the local area network from a remote
location such as a server room. Data are most robustly transferred from the Ion PGM™

Sequencer to the Ion PGM™ Torrent Server when they are directly connected by a
standard Category 6 Ethernet cable provided with the installation materials.

IMPORTANT! The Ion PGM™ Sequencer must be connected to the Ion PGM™ Torrent
Server by a standard Category 6 Ethernet cable. We do not troubleshoot data transfer
issues associated with an indirect connection between the Ion PGM™ and the Ion
PGM™ Torrent Server.

1 Ion PGM™ Torrent Server
2 Ion PGM™ Sequencer
3 Local area network

4 Internet
5 Torrent Browser

  

1

2

2

3
4

5

Chapter 3 System components
System layout3
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Instrument operation

Power the Ion PGM™ Sequencer on or off

Note: If the Ion PGM™ Sequencer is powered on, and the touchscreen is blank, touch
the screen to "wake" the touchscreen.

1. Find the power switch on the back of the instrument and turn to the on (|)
position.

2. Press the power button on the front of the instrument. The switch should
illuminate. When the instrument touchscreen Main Menu appears, the
instrument is ready for use.

3. See the user guide for your sequencing kit for instructions on how to perform an
18-MΩ water or chlorite solution cleaning after powering on.

It is not necessary to power off the instrument overnight or over the weekend. If the
instrument will not be used for more than 3 days, power off the instrument as follows:

1. In the Main Menu, select Tools > Shut Down.

2. If you have not already cleaned the instrument, select 18 MΩ water cleaning,
then press Next to start the cleaning process.

3. When cleaning is complete, press Shut Down.

4. After you exit the main touchscreen, press the Halt button, then OK when
prompted. The instrument will power down.

Update the Ion PGM™ System software

Note: An internet connection is required for the Ion PGM™ System to receive alerts
that software updates are available.

If an update to the Ion PGM™ Sequencer software is available, the red “Alarms and
Events” pop-up appears in the touchscreen Main Menu to alert you. Press the red
pop-up to see the detailed messages. If a message states New Software Available,
update the software as follows:

1. In the Main Menu, select Options4Updates.

2. Select the Released Updates checkbox, then press Check.

4

Power on

Power off
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3. When the message Press Update to begin update process appears, press Update.

Note: If the message All Software Current appears, press Back to return to the
Main Menu.

4. When the message Installing Completed displays, follow the onscreen prompts
to restart the instrument.

Note: In some cases, the instrument restarts automatically after software
installation.

Clean and initialize

See your sequencing guide for instructions on cleaning and initializing the
instrument.

Touchscreen reference

Within the Home screen the Clean, Initialize, and Run programs lead you through
the necessary steps to prepare the instrument for sequencing and to start a sequencing
run.

• Cleaning must be performed before each initialization to ensure that the reagents
from the previous run are cleared from the fluid lines. The Clean program is
normally performed automatically at the completion of the previous sequencing
run. Perform a Clean if for any reason the sequencing run was not properly
completed. Follow the instructions provided on the touchscreen.

• The Initialize program must be performed before each run to load and prepare
the run reagents. The Initialize program walks you through:

– Emptying the waste reservoir.
– Loading the reagent cartridge, wash solution, and cleaning solution. (After

this step, the instrument performs a reagent check.)

Clean, Initialize,
and Run

Chapter 4 Instrument operation
Clean and initialize4
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Simple easy to follow instructions are provided on the touchscreen.
• The Run program walks you through steps leading up to and through

sequencing, including:
– Placing a loaded chip on the instrument.
– Selecting a planned run created in the Torrent Server Software.
– Performing sequencing.

• The Options menu gives you access to software updates.
• The Tools menu gives you access to troubleshooting tools and to the instrument

Shut Down and Reboot commands. See the following table for details.

Options and Tools

Chapter 4 Instrument operation
Touchscreen reference 4
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The Options menu gives you access to software updates and configure instrument
settings.

Options menu

Item Description When/How to use

Updates Checks for and installs updates If alerted by the red "Alarms
and Events" pop-up in the
touchscreen Main Menu (see 
“Update the Ion PGM™

System software“ on page 13
for details):

1. Press Check to
determine if any
software updates are
available.

2. Press Update to install
the updates.

Options

Chapter 4 Instrument operation
Touchscreen reference4
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Item Description When/How to use

Set Time Synchronizes the time on the instrument
with that on the Torrent Server

Use this option to configure
the time on the instrument,
either automatically or
manually:

1. Select either the Auto or
Manual tab then check
the box in the tab.

2. Press Update Time to
confirm and set the
time.

Set IP Allows you to change the instrument name,
confirm the FTP, Torrent Server IP, and
user information

For troubleshooting if
directed to do so by Technical
Support:

1. Touch the screen on the
line you want to edit to
activate the field. A
virtual keyboard will
appear.

2. Enter the new
information, then press
Accept.

Advanced Allows you to set and/or change your
Internet Parameters (DHCP or Static IP)

1. Select either the DHCP
or Static IP tab.

2. Check the box to enable
the internet parameter
of your choice and apply
the option.

Chapter 4 Instrument operation
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Tools menu options

Item Description When to use

AutopH Adjusts the pH of the Wash 2 Bottle
solution and checks the pH. This task
is normally performed by the
instrument as part of the Initialize
program.

If directed to do so by
Technical Support as part of
a troubleshooting
procedure.

ChipCal Runs the chip calibration portion of
the Run program. Chip calibration is
performed by the instrument as part
of the Run program, both before and
after sample is loaded on a chip.

If necessary to calibrate
chips without using the Run
program.

ChipCheck The instrument performs a QC check
of a new chip.

Should be performed before
each sequencing run. For
details consult the
appropriate sequencing
guide.

Data Mgnt Allows you to manually delete run data
or transfer the data the server. Under
normal conditions, run data is
automatically transferred to the
Torrent Server, then deleted from the
instrument hard drive.

To troubleshoot data
management issues. See 
“Error message: Not enough
disk space for the necessary
number of flows“ on
page 36.

Factory Should be used by service engineers
or under their direction only.

N/A

Touchscreen tools

Chapter 4 Instrument operation
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Item Description When to use

Fluidics Should be used by service engineers
or under their direction only.

N/A

Fluid Cal Should be used by service engineers
or under their direction only.

N/A

HardDisk Should be used by service engineers
or under their direction only.

N/A

Leak Test Should be used by service engineers
or under their direction only.

N/A

Line Clear Used to identify and clear blockages in
the waste lines.

See Line Clear procedure in
this guide.

NoiseScreen Provides real-time measurement of
electrical noise readings on the chip.

For troubleshooting if
directed to do so by
Technical Support.

Pressure Cal Should be used by service engineers
or under their direction only

N/A

Reagent Check Measures the pH of all reagents on the
instrument. This task is normally
performed by the instrument as part
of the Initialize program.

If directed to do so by
Technical Support as part of
a troubleshooting
procedure.

Reload Should be used by service engineers
or under their direction only.

N/A

Screen Cal Calibrates the touchscreen. • Follow the onscreen
prompts.

• If the touchscreen
continues to
malfunction after
Screen Cal, contact
Technical Support.

Scripts Runs various procedures on the
instrument.

If directed to do so by
Technical Support as part of
a troubleshooting
procedure.

Shut Down Access to "Shut Down" and "Reboot"
commands.

Note: It is not
necessary/recommended to power off
the instrument overnight or over the
weekend. If necessary to power off the
instrument, see “Power off“ on
page 13.

If directed to do so as part of
a troubleshooting
procedure.

Chapter 4 Instrument operation
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Item Description When to use

View EULA View End User Licence Agreement. Want to check End User
Licence Agreement.

Wideband Test Should be used by service engineers
or under their direction only.

N/A

1. Click on Line Clear (Home screen >Tools>Line Clear )

2. Click on Flow Check.
Common Callouts and Arrows

1.  Copy-paste a callout or arrow to use in this SVG.

     Note:  If you need more advanced callouts or arrows
     use the TechComm_Inkscape_Callout&Arrow_Libary.

3.  Delete this text, this rectangle, and unused
     callouts, arrows, or other SVG elements
     before adding this SVG to the repository.

2.  Edit number and/or line-length, as needed.

1 1

1

1

3. Click on Line Clear.

4. Follow the instructions on the screen.

Press the Gauges icon in the lower right corner of the touchscreen to show or hide the
instrument gauges.

Gauges icon

Line clear
procedure

Touchscreen
gauges

Chapter 4 Instrument operation
Touchscreen reference4
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1 2 3

Label Icon Description

1

Chip compartment temperature. The
expected value when the lid is closed is
35.00 C.

If the icon is red, see “Temperature icon
indicates chip compartment temperature is
out of range“ on page 36.

2

Instrument gas pressure. The expected
value is 10.50 psi during cleaning and
initialization, and 8.0 during a sequencing
run.

If the icon is red, see “Error message:
Confirm instrument has gas pressure“ on
page 37.

3

Percent instrument hard drive and SSD in
use.

If the icon is red, see “Error message: Not
enough disk space for the necessary
number of flows“ on page 36.

Chapter 4 Instrument operation
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Ion Chip™ Minifuge and barcode
scanner

Ion Chip™ Minifuge

The Ion Chip™ Minifuge is supplied with one custom rotor and two buckets. The
buckets are designed to hold two chips: one in each bucket. The rotor and bucket
design enables effective and efficient reagent loading of chips.

CAUTION!
· Make sure your supply voltage matches the voltage label on the minifuge,

i.e., never plug a 120V minifuge into an 220–240 VAC outlet. Operating the
minifuge with a supply voltage outside the specified range may cause a fire
or electric shock.

· Do not run the minifuge for more than 30 seconds.
· Never operate the minifuge without a rotor properly attached to the shaft.
· Never operate with only one chip in place. A chip must be present in each

bucket to balance the rotor. If necessary, you can balance a loaded chip with a
used chip of any type.

· Never put hands in the rotor area unless the rotor is completely stopped.
· Never move the minifuge while the rotor is spinning.
· Do not leave the minifuge running when not in use.

5

Safety precautions
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Two different minifuges are available, depending on your supply voltage: 120 VAC
and 220–240 VAC. Make sure that the voltage specification on the label of your
minifuge matches the supply voltage. If they do not match, change your supply
voltage or contact Customer Support to request the appropriate minifuge.

CAUTION! Never plug a 120V minifuge into an 220–240 VAC outlet, or vice
versa. Operating the minifuge with a supply voltage outside of the range
specified on the label may cause a fire or electric shock.

The following tables list the revolutions per minute (RPM) and relative centrifugal
force (RCF) at different voltages.

120/50 VAC, 60 Hz RPM RCF

90 4100 836

100 4550 1030

110 4960 1224

120 5330 1424

130 5710 1628

230/50 VAC, 60 Hz RPM RCF

210 5070 1279

220 5310 1403

230 5515 1513

240 5705 1619

250 5900 1732

Voltage selection

Voltage, RPM, and
RCF

Chapter 5  Ion Chip™ Minifuge and barcode scanner
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1. Place the Ion Chip™ Minifuge on a level, clean surface near an accessible power
outlet so that the cord and outlet are within easy reach of the operator.

2. Make sure the power switch on the minifuge is in the "off" position.

3. Load a chip into each bucket.

IMPORTANT! A chip must be present in each bucket to balance the rotor. If
necessary, you can balance a loaded chip with a used chip of any type.

4. Turn the power switch on.

5. To begin centrifugation, close the lid of the minifuge. (The centrifugation time
will vary depending on the step in the chip-loading protocol.)

6. To stop centrifugation, press down on the lid release tab on the front of the
minifuge.

CAUTION! Do not attempt to open the lid or remove the chips until the
unit has come to a complete stop.

7. After the rotor has stopped, open the lid by grabbing it with the thumb on the
front and fingers on the back, then lifting the lid back on the hinge.

To clean the minifuge, use a damp cloth and a mild, noncorrosive detergent (pH <8).
After cleaning, ensure that all parts are dried thoroughly before attempting to operate
the unit. Do not immerse the centrifuge in liquid or pour liquids over it.

Note: Use only the cleaning protocol described above.

Operation

Cleaning

Chapter 5  Ion Chip™ Minifuge and barcode scanner
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Barcode scanner

The barcode scanner provided with the Ion PGM™ System uses a low-power, visible-
light diode.

CAUTION! As with any very bright light source, you should avoid staring
directly into the light beam. Momentary exposure to a Class 2 laser is not
known to be harmful.

CAUTION! Use of controls, adjustments, or performance of procedures other
than those specified in this guide may result in hazardous laser light exposure.

The barcode scanner specifications are listed below.

Wavelength Rated Power

630–680 nm 1 mW

Chapter 5  Ion Chip™ Minifuge and barcode scanner
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Sharing Planned Runs between
Torrent Servers

Enable Planned Run sharing

Starting in Torrent Suite™ Software v4.4, Planned Runs created on one Torrent Server
can be transferred to another Torrent Server. This is useful if a sequencer connected to
a particular server is offline or busy.

For example, the figure below illustrates a scenario where three Torrent Servers are on
the same subnet, and a Planned Run created on TS 1 (the "origin" server) is transferred
to TS 3 (the "destination" server) for use on the sequencer connected to TS 3.

TS 1
(origin)

PGM 1 PGM 2 PGM 3

TS 2
(destination)

TS 3
(destination)

Network

Requirements include:
• All Torrent Servers must be on the same subnet.
• All Torrent Servers must be running the same software version.
• All Torrent Servers must have the same genomic reference, barcode set, BED files,

Variant Caller config files, etc.

6
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1. On the origin server (e.g., TS1) Site administration page, scroll down and select
Shared servers. The Select shared server to change window appears.

2. If you are adding your destination server for the first time, click Add shared
server.

3. Define your destination server.
a. Enter the name, address (can be IP address), user name and password for

the destination server.

b. Click Active if you want this server enabled for sharing.

c. (Optional) Add a comment.

d. Click one of the Save options.

4. (Optional) If you want to configure the origin Torrent Server to also be a
destination server, you must go to another server and repeat these steps to set the
origin server as a destination server. Once the Torrent Servers are configured, you
or a user can now transfer Planned Runs between Torrent Servers.

Set up Server
Network (admin
action)

Chapter 6 Sharing Planned Runs between Torrent Servers
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1. Using the Torrent Browser on the origin Torrent Server, go to Plan4Planned Run
List.

2. Open the Gear  menu of the Planned Run you want to transfer, and select
Transfer. Then select the destination Torrent Server.

3. A confirmation window appears. Check the information, then click Transfer.

Note: You can no longer access this Planned Run on the origin server after it has
transferred.

Transfer a
Planned Run

Chapter 6 Sharing Planned Runs between Torrent Servers
Enable Planned Run sharing6

28 Ion PGM™ System Reference Guide



4. A status window displays the results of the transfer:
• The green box lists the samples successfully processed and the required

target BED files found on the destination server.
• The red box lists any required BED files or plugins that are not present on

the destination server. To successfully perform the run, you will need to edit
the transferred Planned Run on the destination server and manually add the
missing BED files or plugins.

5. To edit the transferred Planned Run and add missing files:
a. Download required files using the References tab of the Torrent browser of

the destination server

b. Go to the Edit Plan wizard of the transferred Planned Run by selecting Edit
on the gear pull-down menu to the right of the Planned Run.

c. Select the files or plugins as needed, then click Update Plan.

Note: You can also navigate to the Edit Plan wizard by clicking the Edit test
plan link in the status page above.

Chapter 6 Sharing Planned Runs between Torrent Servers
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1. On the destination server, delete the transferred Planned Run from either the
Planned Run page or the admin page.

2. On the origin server, locate the plan on
the /admin/rundb/plannedexperiment/page, uncheck PlanExecuted and change
PlanStatus to Planned.

If you transferred a Planned Run in error, you can transfer it back to the origin server
or to another server.

1. On the destination Torrent Server, navigate to Plan4Planned Run List and
locate the transferred Planned Run.

2. From the Gear  menu of the Planned Run, select Transfer, then select the
Torrent Server to which you wish to transfer the run.

Undo a Planned
Run transfer
(administrator)

Undo a Planned
Run transfer
(user)

Chapter 6 Sharing Planned Runs between Torrent Servers
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Manually adjust W2 pH

Materials and equipment needed

• Orion Star™ A111 pH Benchtop Meter Kit (Fisher Scientific, Cat. No. 13-645-503),
or equivalent

• Nitrogen gas tank, tube, and flow meter
• 100 mM NaOH (prepared fresh daily)
• Pipette tips and pipette
• Magnetic stirrer and stir bar
• 100 mM HCl

Procedure

If an error message during the automatic pH process indicates that there is a problem
adjusting the pH of the W2 Solution, use the following procedure to adjust the pH of
the W2 Solution in the Wash 2 Bottle manually.

1. Before proceeding, rinse an empty Wash 2 Bottle and have it ready next to the
instrument. Also have an extra Wash 2 Bottle cap ready.

Note: Gas will be flowing out of the Wash 2 cap, so perform the next steps as
quickly as possible (flowing gas will not harm the W2 Solution, and is not a
hazard).

2. Remove the Wash 2 Bottle attached to the instrument, then cap the bottle.

3. Secure the empty Wash 2 Bottle (from step 1) to the instrument—do not remove
the sipper. This bottle contains the gas flowing out of the instrument while adjust
the pH of the W2 Solution, and protects the sipper from contamination.

4. Move the Wash 2 Bottle containing the W2 Solution to the stir plate near the
nitrogen gas tube.

5. Secure the gas tube so that it extends inside the mouth of the Wash 2 Bottle but
not below the surface of the W2 Solution.

6. Set the gas flow to 0.5 lpm. Start mixing the W2 Solution fast sufficient for a small
whirlpool to form.

7. Calibrate the pH meter using a three-point calibration. Rinse any buffering
solution from the pH probe before preparing solutions.

7
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8. Adjust the pH of the W2 Solution to 7.55 ± 0.1 by adding a small amount of
freshly prepared 100 mM NaOH to the solution, then measuring the pH using
the pH meter. Add small aliquots, then allow the pH to equilibrate before adding
more.

Note: If the pH rises above 7.75, use 100 mM hydrochloric acid (HCl) to readjust
the pH to 7.55 ± 0.1.

9. When the pH is stable, turn off the gas, remove the gas line, then cap the Wash 2
Bottle.

10. Move the bottle to the instrument, remove the empty Wash 2 Bottle from the
instrument, then place the sipper inside the Wash 2 Bottle whose pH adjusted.

11. Secure the cap firmly. Press Next to exit the automated pH check, then continue
with instrument initialization.

Chapter 7 Manually adjust W2 pH
Procedure7
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Sequencing run times

Number of flows Average read
length [1]

Average run time by chip
type: 314/316/318

Single read
runs/kit[2]

850 400 bp 4.8 / 6.3 / 9.4 hours 4

500 200 bp 2.4 / 3.1 / 4.5 hours 8

260 100 bp 1.3 / 1.7 / 2.4hours 12

[1] Read length may vary based on library size. 
[2] Only 4 runs are supported for any read length. For best results, run should be started within 1 hour after 

initialization. 

8
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Troubleshooting

Alarms/events pop-up

If the red Alarms/Events pop-up appears, press the pop-up to see detailed messages.

Alarm/Event message Recommended action

Pressure too low 1. Verify that the gas cylinder has at least 500 PSI and
30 PSI at the outlet of the regulator. Confirm that all
valves between the cylinder and the Ion PGM™

Sequencer are open.

2. Once you confirm gas pressure leading to the
instrument, press Yes to retry verification of gas
pressure. If the test continues to fail, contact
Technical Support.

Pressure too high Ensure input pressure to the Ion PGM™ Sequencer is
correct.

A
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Alarm/Event message Recommended action

Failed to set digital pressure
regulator Check input pressure.

Temperature too low/high Verify that lab temperature meets the recommendation. If
temperature is normal and alarm persists, contact
Technical Support.

Unable to read internal
temperature

Contact Instrument Hardware Services.Unable to read chip
temperature

Results drive not accessible

Bad boot drive detected

Contact Field Services.

Valve board not accessible

Valve board downstream
errors

Fan current usage low

Heater current usage low

FPGA memory test failed

Bad results data drive
detected

Contact Technical Support.Unexpected image file size

Hard drive write slow
possible due to bad hard
drive

U-boots don't match Contact Technical Support.

Kernels don't match Contact Technical Support.

Potentially losing connection
to Torrent Server

1. Disconnect, then re-connect the ethernet cable.

2. Confirm the router is operational.

3. Verify that the network is up and running.

No connectivity to Torrent
Server

No connectivity to FTP
server

Appendix A Troubleshooting
Alarms/events pop-up A
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Alarm/Event message Recommended action

Cannot connect to Torrent
Server due to

• invalid user ID or
password

• invalid IP address

1. Check that your user id and/or password are correct.

2. If alarm persists:

a. Power off the instrument: In the Main menu,
select Tools4Shut Down4Shut Down.

b. Wait 30 seconds, then press the button on the
front of the instrument to power on the
instrument.

3. If the message still appears in the main menu,
contact Technical Support.

Newer software available Update your software. See “Update the Ion PGM™ System
software“ on page 13.

Observation Possible cause Recommended action

Error message: Not enough
disk space for the necessary
number of flows

(The sequencer hard drive
does not contain enough
space for the Planned Run)

and/or

Hard drive icon indicates hard
drive is almost full ( )

Data normally transfer
automatically from the hard
drive to the Torrent Server,
however this may not happen
in the case of:

• Data transfer manually
aborted by user

• Issue with connectivity or
network

• Incorrect configuration of
the Torrent Server

1. Check for connectivity or network issues, for
example, unplug and replug the ethernet
cable, confirm that the router is operational,
and verify that the network is up and running.

2. If in "Select Planned Run", select Data
Management in the touch screen, otherwise
select Tools4Data Management from the
Main Menu.

3. In the Data Management screen, select All,
then review the runs. If there are runs that do
not need to be transferred to the Torrent
Server (for example test or aborted runs),
select the checkbox next to the run names,
then press Delete Sel.

4. If there are runs that you do want to transfer,
you may need to wait until connectivity is
restored for the run to transfer and then
autodelete.

Temperature icon indicates
chip compartment
temperature is out of range

Thermistor in chip
compartment is damaged

Contact Technical Support.

Note: Do not perform sequencing runs until this
problem is corrected; non-optimal temperatures
in the chip compartment may affect sequencing.

Appendix A Troubleshooting
Alarms/events pop-upA
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Initialization—General errors

Observation Possible cause Recommended action

Error message: Confirm
instrument has gas pressure

Gas cylinder may be turned off
or empty.

1. Verify that the cylinder has at least 500
PSI and 30 PSI at the outlet of the
regulator. Confirm that all valves between
the cylinder and the Ion PGM™ Sequencer
are open.

2. Once you confirm gas pressure leading
into the instrument, press Yes to retry
verification of gas pressure. If the test
continues to fail, contact Technical
Support.

Bottle leak check fails • Bottle seal is not tight.

• Bottle may be damaged /
defective.

1. Finger-tighten the bottles.
2. If the bottle continues to leak, replace the

bottle.
3. If leak check continues to fail, contact

Technical Support.

Appendix A Troubleshooting
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Initialization—Auto pH errors

Observation Possible cause Recommended action

Error message: Please insert
a chip and press Start

Instrument cannot detect the
chip in chip socket.

1. Open the chip clamp and remove the chip.
2. Check for debris under the chip or in the chip

socket. Remove any debris by rinsing with
18-MΩ water and gently dabbing the socket
with a lab wipe tissue.

IMPORTANT! Never rub or wipe the socket.
Rubbing the socket can damage it and cause
it to fail.

3. Look for liquid outside the flow cell of the
chip:

4. If you see liquid, replace the chip with a new
(unused) one. Wash the new chip once with
100% isopropanol and twice with SEQ Sample
Buffer before using.

Note: The new chip can be used for
sequencing after initialization completes.

5. Close the clamp, then press Start to restart
the process.

6. If the new chip also fails, there could be a
problem with the chip socket. Contact
Technical Support.

Error message: Chip
calibration failed

• Chip is not seated in
socket correctly.

• Chip is damaged.

• Sipper is loose.

Follow the procedure for "Error message: Please
insert a chip and press Start."

Follow the procedure for "Error message: Wash 2
average not stable."

Appendix A Troubleshooting
Initialization—Auto pH errorsA
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Observation Possible cause Recommended action

Error message: The system
did not reach the target W2
pH and/or has a clog

The waste lines can be
clogged.

1. Press the Troubleshoot button.

Note: You can skip the Troubleshoot button
and change the chip to restart the Auto-pH
routine.

2. Remove the waste bottle.
3. Place lab wipes under the waste arm.
4. Gently wipe the waste arm with a lab wipe to

clear liquid near the waste line.

5. Press Next to start buffer flow. Observe flow
rates from both waste lines. One line should
drip slightly faster than the other. Following
the flow rate check, one of 3 results is
possible:

a. If flow rate appears normal, press
Cancel and test another chip. If Auto pH
failure persists, contact Technical
Support.

b. If flow is blocked, press Line Clear to
run the standard Line Clear procedure.
If the line is unable to clear, contact
Technical Support.

c. If the result of the flow rate check is
uncertain, press Re-flow to re-flow the
buffer and re-test the flow.

Appendix A Troubleshooting
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Observation Possible cause Recommended action

Error message: The system
did not reach the target W2
pH (continued)

Wash 1 or Wash 2 sipper may
be loose.

1. Loosen the Wash 1 cap and re-tighten the
sipper. Since the gas flows when the cap is
loose, tighten the sipper as quickly as
possible. (The gas is not harmful to the NaOH
solution and is not a hazard.)

2. Loosen the Wash 2 cap and re-tighten the
sipper. Since the gas flows when the cap is
loose, tighten the sipper as quickly as
possible. (The gas is not harmful to the W2
Solution and is not a hazard.)

3. Press Start to re-start the auto-pH process.

Forgot to add NaOH to the
Wash 1 Bottle.

1. If there is no NaOH in the Wash 1 Bottle,
loosen the cap and add 350 µL of 100 mM
NaOH to the Wash 1 Bottle. (The flowing gas
is not harmful to the NaOH solution and is
not a hazard.)

2. Recap the bottle and shake gently to mix.
3. Press Start to restart auto-pH.

Chip is damaged. 1. Replace the chip with a new (unused) one.
Insert the chip in the socket, then press
Start.

Note: The new chip can be used for
sequencing after initialization completes.

2. If the error persists, there could be a
problem with the chip clamp. Contact
Technical Support.

Appendix A Troubleshooting
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Observation Possible cause Recommended action

Error message: W2 average
not stable. Try
reseating/replacing chip

Reading for W2 solution is not
stabilizing quickly enough.

1. Remove the waste bottle and gently wipe
excess fluid from the waste lines with a lab
wipe.

2. Check for leaks and reseat the chip (see
troubleshooting for "Chip Check" and "Chip
calibration" above). Replace the chip with a
new (unused) one if needed.

Note: The new chip can be used for
sequencing after initialization completes.

3. Loosen the cap in the W2 position and re-
tighten the sipper. Because the gas flows
when the cap is loose, tighten the sipper as
quickly as possible. (The gas is not harmful
and not a hazard.)

4. After performing one or more above steps,
press Start to re-start auto-pH. If auto-pH
fails even after replacing the chip, contact
Technical Support and manually adjust the
pH of the Wash 2 Bottle as described in
"Manually adjust W2 pH" in the Ion PGM™

System Reference Guide (Pub. No.
MAN0009783).

Error message: W2 out of
range

• Chip measurements are
very unstable.

• Chip is damaged.

See troubleshooting tips for "W2 average not
stable" above.

Error message: Chip reading
inconsistent. Please replace
chip and try again

• pH response of the chip
is not uniform or reliable.

• Ran out of W3 Solution or
volume too low.

1. Verify that there is enough W3 Solution (>25
mL) in the Wash 3 Bottle and that the sipper
is secure.

2. If necessary, loosen the Wash 3 Bottle cap,
tighten the sipper, and add more W3 Solution
to fill to 50 mL. Since the gas flows when the
cap is loose, perform these operations as
quickly as possible. (The gas is not harmful to
the W3 Solution and is not a hazard.)

3. If there is enough W3 Solution, replace the
chip with a new (unused) one. Insert the chip
in the socket, then press Start.

Note: The new chip can be used for
sequencing after initialization completes.

Appendix A Troubleshooting
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Observation Possible cause Recommended action

Error message: Added too
much W1 to W2

• Water quality is poor.

• 18 MΩ water was
exposed to air for too
long.

• Incorrect solution was
added to the Wash 2
Bottle.

• Too little NaOH was
added to Wash 1 Bottle.

• Chip is damaged.

1. Check whether the water meets the 18 MΩ
specification and 100 mM NaOH and
W2 Solution were added correctly.

2. If solutions are incorrect or water does not
meet specifications, correctly prepare the
solution(s) and/or use high-quality water.
Abort the initialization and restart using
correct solutions/water.

3. If solutions are correct and water meets
specifications, abort the initialization, return
to the main menu, and proceed to the next
steps.

4. Leave the Wash 2 Bottle on the instrument.
5. Remove the Wash 1 Bottle, leaving the sipper

on the W1 port. Empty the bottle, and rinse
the bottle twice with 18 MΩ water.

6. Add 350 μL of 100 mM NaOH to the Wash 1
Bottle and reinstall on the instrument.

7. Press Initialize, select the kit type, and keep
pressing the Next button to skip all bottle
prep steps until the instrument begins
purging air from the bottle. Then proceed
through the touchscreens as normal to
complete the initialization.

8. The next time you initialize the instrument,
add 140 μL of 100 mM NaOH to the Wash 2
Bottle instead of 70 μL. Continue to use this
larger volume for subsequent initializations
until you receive an "Overshot Target" error
message at the first auto-pH iteration, at
which point follow the troubleshooting steps
in “Error message: The system overshot the
target W2 pH.“ on page 43, then return to
adding 70 μL of 100 mM NaOH.

9. If you still receive the same initialization
error ("Added too much W1 to W2"), contact
Technical Support.

Error message: UNDERSHOT
TARGET PH: W2 pH = n.nn
Failed

Auto-pH couldn't add enough
Wash 1 to the Wash 2 before
the maximum iterations, 10,
occurred.

1. A blockage may have occurred. Follow the
procedure for "Error message: There may be
a blockage or no NaOH in W1. Please check
W1 and run line clear then try again."

2. Press Start to re-start auto-pH. If you still get
the "Undershot target pH" error, try replacing
the chip with a new (unused) chip and
restarting auto-pH.

Note: The new chip can be used for
sequencing after initialization completes.

Appendix A Troubleshooting
Initialization—Auto pH errorsA
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Observation Possible cause Recommended action

Error message: The system
overshot the target W2 pH.

Auto-pH added more NaOH
from the Wash 1 Bottle to the
Wash 2 Bottle than was
needed, and reports the pH
value.

1. Press the Overshoot button to proceed with
W2 pH adjustment.

2. Unscrew the cap of the Wash 2 Bottle.
Without removing the sipper from the bottle,
lift the cap high enough to pipette 15 µL of
100 mM HCl into the Wash 2 Bottle, close and
tighten cap.

3. Press Next to re-pressurize the Wash 2
Bottle and mix the W2 solution.

4. Press Start to retry auto-pH.

Initialization—Reagent pH verification

Observation Possible cause Recommended action

Red failure screen, reagent pH
is displayed

One or more reagents are not
within the target pH.

1. Press Start to repeat the pH
measurements to confirm the
measurement.

2. If any reagents still fail, try replacing the
chip with a new (unused) chip and
repeating.

Note: The new chip can be used for
sequencing after initialization completes.

3. If any reagents still fail, clean and re-
initialize the instrument with fresh
reagents and a new chip.

A possible line clog exists
which persisted through the
Auto pH process.

1. From the Tools menu, perform a W1 line
clear.

2. Press Start to repeat the pH check.

Appendix A Troubleshooting
Initialization—Reagent pH verification A
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Observation Possible cause Recommended action

Red failure screen, reagent pH
is not displayed

Chip did not calibrate. 1. Replace the chip with a new (unused) one.

Note: The new chip can be used for
sequencing after initialization completes.

2. Press Start to restart the pH
measurement.

3. If the second test fails, contact Technical
Support.

Appendix A Troubleshooting
Initialization—Reagent pH verificationA
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Safety

WARNING! GENERAL SAFETY. Using this product in a manner not specified
in the user documentation may result in personal injury or damage to the
instrument or device. Ensure that anyone using this product has received
instructions in general safety practices for laboratories and the safety
information provided in this document.

· Before using an instrument or device, read and understand the safety
information provided in the user documentation provided by the
manufacturer of the instrument or device.

· Before handling chemicals, read and understand all applicable Safety Data
Sheets (SDSs) and use appropriate personal protective equipment (gloves,
gowns, eye protection, etc). To obtain SDSs, see the “Documentation and
Support” section in this document.

Symbols on this instrument

Symbols may be found on the instrument to warn against potential hazards or convey
important safety information. In this document, the hazard symbol is used along with
one of the following user attention words:

• CAUTION! – Indicates a potentially hazardous situation that, if not avoided,
may result in minor or moderate injury. It may also be used to alert against
unsafe practices.

• WARNING! – Indicates a potentially hazardous situation that, if not avoided,
could result in death or serious injury.

• DANGER! – Indicates an imminently hazardous situation that, if not avoided,
will result in death or serious injury.

Symbol English Français

Caution, risk of danger

Consult the manual for further safety
information.

Attention, risque de danger

Consulter le manuel pour d’autres
renseignements de sécurité.

Protective conductor terminal (main
ground)

Borne de conducteur de protection
(mise à la terre principale)
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Symbol English Français

Do not dispose of this product in
unsorted municipal waste

CAUTION! To minimize
negative environmental
impact from disposal of
electronic waste, do not
dispose of electronic waste in
unsorted municipal waste.
Follow local municipal waste
ordinances for proper
disposal provision and
contact customer service for
information about responsible
disposal options.

Ne pas éliminer ce produit avec les
déchets usuels non soumis au tri
sélectif.

CAUTION! Pour minimiser
les conséquences négatives
sur l’environnement à la suite
de l’élimination de déchets
électroniques, ne pas élimin-
er ce déchet électronique
avec les déchets usuels non
soumis au tri sélectif. Se con-
former aux ordonnances lo-
cales sur les déchets munici-
paux pour les dispositions
d’élimination et communi-
quer avec le service à la cli-
entèle pour des renseigne-
ments sur les options d’élimi-
nation responsable.

Safety alerts on this instrument

Additional text may be used with one of the symbols described above when more
specific information is needed to avoid exposure to a hazard. See the following table
for safety alerts found on the instrument.

English French translation

CAUTION! Hazardous chemicals.
Read the Safety Data Sheets (SDSs)
before handling.

ATTENTION! Produits chimiques
dangereux. Lire les fiches signalétiques
(FS) avant de manipuler les produits.

CAUTION! Hazardous waste. Refer
to SDS(s) and local regulations for
handling and disposal.

ATTENTION! Déchets dangereux. Lire les
fiches signalétiques (FS) et la
réglementation locale associées à la
manipulation et à l’élimination des déchets.

Safety
Safety alerts on this instrument
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Safety information for instruments not manufactured by Thermo
Fisher Scientific

Some of the accessories provided as part of the instrument system are not designed or
built by Thermo Fisher Scientific. Consult the manufacturer's documentation for the
information needed for the safe use of these products.

Instrument safety

CAUTION! Do not remove instrument protective covers. If you remove the
protective instrument panels or disable interlock devices, you may be exposed
to serious hazards including, but not limited to, severe electrical shock, laser
exposure, crushing, or chemical exposure.

CAUTION! Moving Parts. Moving parts can crush, pinch and cut. Keep hands
clear of moving parts while operating the instrument. Disconnect power before
servicing.

WARNING! Ensure appropriate electrical supply. For safe operation of the
instrument:

· Plug the system into a properly grounded receptacle with adequate current
capacity.

· Ensure the electrical supply is of suitable voltage.
· Never operate the instrument with the ground disconnected. Grounding

continuity is required for safe operation of the instrument.

WARNING! Power Supply Line Cords. Use properly configured and approved
line cords for the power supply in your facility.

WARNING! Disconnecting Power. To fully disconnect power either detach or
unplug the power cord, positioning the instrument such that the power cord is
accessible.

General

Physical injury

Electrical

Safety
Safety information for instruments not manufactured by Thermo Fisher Scientific
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CAUTION! Cleaning and Decontamination. Use only the cleaning and
decontamination methods specified in the manufacturer's user documentation.
It is the responsibility of the operator (or other responsible person) to ensure
the following requirements are met:

· No decontamination or cleaning agents are used that could cause a
HAZARD as a result of a reaction with parts of the equipment or with
material contained in the equipment.

· The instrument is properly decontaminated a) if hazardous material is
spilled onto or into the equipment, and/or b) prior to having the instrument
serviced at your facility or sending the instrument for repair, maintenance,
trade-in, disposal, or termination of a loan (decontamination forms may be
requested from customer service).

· Before using any cleaning or decontamination methods (except those
recommended by the manufacturer), users should confirm with the
manufacturer that the proposed method will not damage the equipment.

CAUTION! LASER HAZARD, Bar Code Scanner. The bar code scanner
included with the instrument system is a Class 2 laser. To avoid damage to eyes,
do not stare directly into the beam or point into another person's eyes.

Safety and electromagnetic compatibility (EMC) standards

The instrument design and manufacture complies with the standards and
requirements for safety and electromagnetic compatibility as noted in the following
table:

Reference Description

EU Directive
2006/95/EC

European Union “Low Voltage Directive”

IEC 61010-1

EN 61010-1

UL 61010-1

CSA C22.2 No.
61010-1

Safety requirements for electrical equipment for measurement,
control, and laboratory use – Part 1: General requirements

IEC 61010-2-010

EN 61010-2-010

Safety requirements for electrical equipment for measurement,
control and laboratory use – Part 2-010: Particular requirements
for laboratory equipment for the heating of materials

Cleaning and
decontamination

Laser

Safety

Safety
Safety and electromagnetic compatibility (EMC) standards
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Reference Description

Directive
2004/108/EC

European Union “EMC Directive”

EN 61326-1 Electrical Equipment for Measurement, Control and Laboratory
Use – EMC Requirements – Part 1: General Requirements

FCC Part 15 U.S. Standard “Industrial, Scientific, and Medical Equipment”

AS/NZS 2064 Limits and Methods of Measurement of Electromagnetic
Disturbance Characteristics of Industrial, Scientific, and Medical
(ISM) Radiofrequency Equipment

ICES-001, Issue 3 Industrial, Scientific and Medical (ISM) Radio Frequency
Generators

Reference Description

Directive 2012/19/EU European Union “WEEE Directive” – Waste electrical and
electronic equipment

Directive 2011/65/EU European Union “RoHS Directive” – Restriction of hazardous
substances in electrical and electronic equipment

EMC

Environmental
design

Safety
Safety and electromagnetic compatibility (EMC) standards
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Chemical safety

WARNING! GENERAL CHEMICAL HANDLING. To minimize hazards,
ensure laboratory personnel read and practice the general safety guidelines for
chemical usage, storage, and waste provided below. Consult the relevant SDS
for specific precautions and instructions:

· Read and understand the Safety Data Sheets (SDSs) provided by the
chemical manufacturer before you store, handle, or work with any chemicals
or hazardous materials. To obtain SDSs, see the “Documentation and
Support” section in this document.

· Minimize contact with chemicals. Wear appropriate personal protective
equipment when handling chemicals (for example, safety glasses, gloves, or
protective clothing).

· Minimize the inhalation of chemicals. Do not leave chemical containers open.
Use only with adequate ventilation (for example, fume hood).

· Check regularly for chemical leaks or spills. If a leak or spill occurs, follow
the manufacturer's cleanup procedures as recommended in the SDS.

· Handle chemical wastes in a fume hood.
· Ensure use of primary and secondary waste containers. (A primary waste

container holds the immediate waste. A secondary container contains spills
or leaks from the primary container. Both containers must be compatible
with the waste material and meet federal, state, and local requirements for
container storage.)

· After emptying a waste container, seal it with the cap provided.
· Characterize (by analysis if necessary) the waste generated by the particular

applications, reagents, and substrates used in your laboratory.
· Ensure that the waste is stored, transferred, transported, and disposed of

according to all local, state/provincial, and/or national regulations.
· IMPORTANT! Radioactive or biohazardous materials may require special

handling, and disposal limitations may apply.

Safety
Chemical safety
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Documentation and support

Obtaining information from the Help system

The Ion PGM™ Instrument has a Help system that describes how to use each feature
of the user interface. Access the Help system by doing one of the following:

• Click in the toolbar of the window.
• Select Help4Contents and Index.
• Press F1.

You can use the Help system to find topics of interest by:
• Reviewing the table of contents
• Searching for a specific topic
• Searching an alphabetized index

You can also access PDF versions of all documents in the document set from the Help
system.

Customer and technical support

Visit thermofisher.com/support for the latest in services and support, including:
• Worldwide contact telephone numbers
• Product support, including:

– Product FAQs
– Software, patches, and updates
– Training for many applications and instruments

• Order and web support
• Product documentation, including:

– User guides, manuals, and protocols
– Certificates of Analysis
– Safety Data Sheets (SDSs; also known as MSDSs)

Note: For SDSs for reagents and chemicals from other manufacturers,
contact the manufacturer.

Ion PGM™ System Reference Guide 51

http://thermofisher.com/support


Limited product warranty

Life Technologies Corporation and/or its affiliate(s) warrant their products as set forth
in the Life Technologies' General Terms and Conditions of Sale found on Life
Technologies' website at www.thermofisher.com/us/en/home/global/
terms-and-conditions.html. If you have any questions, please contact Life
Technologies at www.thermofisher.com/support.

Documentation and support
Limited product warranty
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For support visit thermofisher.com/support or email techsupport@lifetech.com

thermofisher.com

13 January 2017
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